Using Brainstorm
Very often, you model a system not just by imagination, but with facts, knowledges and customers' ideas. You may meet with users, understand how
they work, identify their requirements and proceed to visualize their needs with models.

Logizian enables you to record important ideas during a meeting through a note-taking feature called "Brainstorm". During the meeting, you create
note (shapes) in a corkboard -like diagram. When the meeting ends, you may organize the notes, and derive a diagram from them. This helps ensure
all important thoughts from users are well recorded and won't be lost when constructing a model.

A sample Brainstorm diagram

Creating Brainstorm diagram
In order to start taking notes, you need to create a Brainstorm diagram. There are three ways you may take to create a Brainstorm diagram:

. Diagram Navigator - Right click on Brainstorm in Diagram Navigator and select New Brainstorm from the popup menu.
. Toolbar - Click on the Diagrams button in toolbar and select Brainstorm from the drop-down menu.
. Menu - Select File > New Diagram > Others > Brainstorm from the main menu.

Creating a note
Brainstorm diagram applies a corkboard theme. You may add notes to it to record ideas and thoughts collected. To create a note:

1. Press and drag in diagram toolbar a note with the desired color.
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Creating a note

2. Release the mouse button on the diagram to create a note.

3. Enter the note content. Press Ctrl-Enter to finish editing.

received orders

W Tag

A note is created

Imagine when you are having a meeting with user and taking notes with Brainstorm, you may not be perfectly sure whether the notes you

create are utlimately important or not. As long as you think that the information may help you model, it is worthwhile to note it down for now. The
key idea is to add notes in a casual manner. Do not spend too much time on judging the importance of the content. Otherwise, you may miss out
information that is really important during the process of strenuous sorting.

Deleting a note
If a note has been created by mistake or the note text is no longer correct/meaningful, you may want to delete the note. To delete a note, you may
select it and press the Delete key. Alternatively, press on the cross button at top left of note shape to perform a deletion.
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Realizing Brainstorm Notes

Logizian enables you to record important ideas during a meeting through a note-taking feature called "Brainstorm". During the meeting, you pay
attention to what the participants say and create note (shapes) in a corkboard -like diagram to record the key points. After the meeting, you may make
use of the notes collected to help you construct the model. To optimize the process, Logizian supports a realize function to transform notes into model
elements.

Producing a task from a note

To realize a note:

1. Look for the note that can help you construct a model element. For example, when you see a note with text "ship goods", you may want to
create a task Ship Goods from it.

2. Click on Tag at bottom left of note body. Select the type of element from the popup menu, such as Task.
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Select note type

3. Click the tag at bottom left and select Realize... from the popup menu.
In the Transit Model Element window, enter the properties of the model element you are going to produce. Click OK at bottom right to continue.

The Visualize Model Element window enables you to show the model element on a diagram. You may show it on a new diagram by selecting
Create new diagram and entering the diagram name. Or, show it in an existing diagram by selecting Show in existing diagram and selecting the
diagram to show. Or, not to show it on any diagram by selecting Do note visualize. Click Create/ Show/ Close at bottom right.

Changing note tag

If you have selected a tag for a note and you want to change it, click on any tag at bottom left of note shape and select Type > [New Tag] from the
popup menu. This will clear the previously select tag and apply the newly selected one. Note that once a tag has been realized, you cannot change it to
another type anymore.

Adding note tag
You may add multiple tags to a note and realize multiple model elements from different tags (one model element per tag). To add another tag, click on
any previously added tag at bottom left of note shape and select Add > [New Type] from the popup menu.

Deleting note tag

If you think that a note tag is no longer suitable for the note, you may delete it. To delete a tag, click on the tag you want delete from note and select
Delete from the popup menu. Note that if the tag has been realized, deleting the tag would not delete the realized model element. And if you add the
tag again, the realization relationship will be maintained.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks. Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Recording requirements

Before you start business process modeling, you usually have to discuss with your customers about their needs and to familiarize yourself with their
company's operations as well as their problems. During the meeting you can collect useful information from customer, which include the conversation
log, documents. You can make use of textual analysis, a text-based editor, to help record those textual information. In addition to a plain text editor, you

can identify important terms or objects (e.g. class, use case) from the problem description.

Creating textual analysis

To create textual analysis, right click Textual Analysis on Diagram Navigator and select New Textual Analysis from the pop-up menu.
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Create a textual analysis

Problem statement editor

The problem statement editor is where you can record the textual information you obtain from your customers.

" tenual Analysis1 =
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dText | Tvoe | Oescription | occurrence] Highi..|

Problem statement editor

All buttons on editor's toolbar are depicted in the following table:

Editor's toolbar

No. Name Description

1 Bold Set the highlighted text to bold.
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2 ltalic Set the highlighted text to italic.

3 Underline Underline the highlighted text.

4 Left Justify Set the alignment of highlighted text to the left.

5 Center Justify Set the alignment of highlighted text to the center.

6 Right Justify Set the alignment of highlighted text to the right.

7 Ordered list Add a numbered list.

8 Un-ordered list Add a list with bullet points.

9 Font Select the font family of highlighted text.

10 Font size Select the size of highlighted text.

11 Font color Select the color of highlighted text.

12 Table Add a table.

13 Background color Select the background color of highlighted text.

14 Clear formats Clear formats of the whole editor to convert the content to plain text.
15 Link Add a hyperlink.

16 Image Add an image.

17 Add Model Element... Insert an existing model element or create a new one.

The description of buttons on problem statement's toolbar

Entering problem statement
Three ways of entering problem statement are provided in Logizian.

. Typing on the editor
. Importing an external text file

. Copying and pasting from an external source

To type in the editor, type the problem statement directly on the editor.

To import a text file, click Import File on the toolbar.
—  Textual Analysis1
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Import file

When the Open dialog box pops out, select a text file to import. As a result, the imported problem statement will be shown on the text area.

To copy and paste from an external source, press Ctrl + C on the selected text and press Ctrl + V for pasting it on the editor.

Formatting text

Since Logizian supports rich text format (RTF), you can format the problem statement on the editor, such as making it bold, italic, or inserting a table.

1. To format text, highlight the target word/ phrase in advance.
—  Textual Analysis1
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2. Next, click a corresponding button on the toolbar. i.e. Click Italic button to make the target word italic.

Click Italic button

Finding a keyword

You can search your target word/phrase in problem statement in shortcut through Find feature. Click Find button on the toolbar and then enter the

word/ phrase in Search Text. Finally, click Find button next to Search Text. As a result, the word/ phrase matching you typed will be highlighted.

M
228 s=AERA

Search Text: memberships [F‘s\
]
]

EEFRherf-@ 2T

There are two kinds of - emmm
general and premium. It is free of
charge for visitors to register as a
general member to watch any archived TV
programs. On the other hand, they can
register as a premium member to watch
both archived and live programs, for US
530 per month. A general member can
uparade himself to a premium member E

Class_| dText | Type | |

The word memberships is highlighted in problem statement

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube
. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Identifying important terms

A word usually can have various meaning under different domains. To clarify and standardize the meaning of your specific word, you can extract it from
textual documentation to define it as a glossary term. After adding the word as glossary term, you can define its aliases and enter its documentation to
provide additional information. In textual analysis, you can define a specific word by highlighting it on problem statement editor and add it to glossary.
After that, define aliases and enter documentation for the glossary term in term editor.

1.

3.

Highlight the specific term on problem statement editor, right click on it and select Add [the highlighted term] to Glossary from the pop-up
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When the Glossary Grid page unfolds, enter name for the glossary grid and then right click on the newly created term and select Open Term
Editor from the pop-up menu.

B aERA8RL LA

Name Aliases Labels Documentation

Online register
|Ei Open Term Editor h |’>

3 Create Term

Right click to open term editor

In the Term Editor page, open Definition tab.

You can define aliases for the term and enter documentation as definition for the term. To insert an alias, click Add button to type the alias in the

pop-up Input dialog box. To enter the definition of the term, enter under Definition directly.

"= Torm Editor - Online register =~
Defrvtor | Swereotypes | Tagged vakues

Term:  Oriine regster Edit

.

Defirston:
HTML *BIUT=EZEEFRbM-d LT ER-&
Sign up as & meskes] vis OTV's coline register page.

Define aliases and enter documentation

As a result, the columns of Aliases and Documentation are filled when you return Glossary Grid page.

Es 85RO R Wwe proec
Hame | Aliases |Labels | Documentation |
Oniine register Sign up | |Sign up as a member via OTV's onine register page.

Completed glossary grid

NOTE: If the Aliases column is hidden, you can click Configure Columns... button to make it revealed. Open Properties tab and select it
under Details folder.

Related Resources
The following resources may help you learn more about the topic discussed in this page.

New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
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Visual Paradigm on YouTube
Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

Contact us if you need any help or have any suggestion
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Identifying candidate objects

By studying the problem statement, you can extract words or phrases that are relevant to the system and convert them into model elements, such as
task and sub-process, etc. Those objects are regarded as candidate objects. You can extract words or phrases from problem statement to become
specific type of candidate objects, and edit their properties when necessary.

Identifying candidate objects
Highlight the word/ phrase from the problem statement and select Add text as [model element type] from the pop-up menu.

both archived and live programs, for US
$30 per month. A general member can
upgrade himself to a premium member
anytime he wants to. However, premium
member is not allowed to change himself
back to a general member. Members can

remove his/her account permanentl by

malll Add text as
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BE= Lane

Select actor as its type

Editing candidate objects
You can rename candidate objects, change their type, write their description and change their color of highlight in the grid at the bottom of textual
analysis.

To rename the candidate object:

Double click on the Candidate Class cell and rename the candidate object.
~

Ho. d Text Type ] | Highh...|
Watch archived programs | Jwatch any archived 1) Task
upgrade himseF to a premjupgrade himself to a ) Task

posting their opinion posting their opinion (&) Sub-Pro...
update the program schegupdate the program (& Sub-Pro...

Bfw =
el Gl

Rename candidate object

To change the candidate object's type:

Double click on the Type cell and select a type from the combo box.

rFs, 4

No. Candidate Class " Extracted Text Type
1 |Watch archived programs|watch any archived 1_J Task
2
3
4

Upgrade to premium mem upgrade himself to a |_J Task
POSE OpINio e g OpINio Sub-Process

Update program schedule|update the program |23 Package -

Sub-Proc

Start Event

Intermediate Ex| -

End Event 1
0 Pool

Lane

F]

Select task as its type

To add description for the candidate object:
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Double click on Description cell and type text inside the cell.

Type f Descripti ‘Occurrence
D Task :Ifmbers can watch archived programs 3
< | i | 3 1
(O Task 1
Sub-Process 1
Sub-Process 1
Enter description

NOTE: The text you typed in Description cell will become the documentation of the model element which you used to create candidate object.

To change the highlight color of candidate object in problem statement:

1. Click the Highlight cell and press the inverted triangle.

2. Select a color from the combo box.

Description Occurrence
embe g 3 d ed p

General Members can upgrade th 1

Premium Members can post thiel 1
The Administrator has the right ¢ 1

|| [[]IM8:

Select the highlight color

Related Resources

The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Forming diagram from candidate objects
In problem statement editor, you can form a diagram from candidate objects, or show it in an existing diagram by visualizing it.

1. Right click on the target candidate object and select Create [candidate object&rsquo;s type] Model Element from the pop-up menu.
remove his/her account permanently by .

Members can Wi

Add "Watch archived programs" to Glossary
posting ther opinion (&) Sub-f Fit All Rows Height
update the program &) Sub-f  Fig Selected Row Height

:

Create a model element

2. In the Visualize Model Element dialog box, either check Create new diagram to show your model element on a new diagram or check Show
in existing diagram to show on an existing diagram. Finally, click the Show button to proceed.

(&) Visualize Model Element i

You can choose one of the following visualization options to show the models in new dagram or exsting diagram.
Visuslization Options
EﬁCrealg new dagram
Diagram name: |Register- First tme visit] a Busness Process Diagram =
") Show in existing diagram v »
Show al types of diagram

m untitied

Do not visualize

| creste

Check an option in Visualize Model Element dialog box

As a result, the model element will be shown on the selected diagram.

NOTE: If you have already made a model element for the candidate object, the Create Model Element option will be hidden even after you right
click on it.

Dragging and dropping candidate objects
You can visualize existing candidate objects by dragging from Model Explorer and dropping on the diagram.

To visualize a candidate object or several candidate objects, select a candidate object (or a few candidate objects) from Model Explorer, drag and
drop it(or them) on the target diagram. As a result, the view of the selected candidate object(s) will be shown on diagram.

Epiw.- . qu..'j:?,m'ca,‘} [E) Business Process Diagram1 '
‘—um 3 8 % W

U'ﬁ\'“"‘al <unmedﬁed>|;:
T untitied
(= [ Canddate ltem
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a . a .
[ Watch Archived Program It 3
d e £ Login Upgrade o Premium Membership
= L] L L]
‘ m »

Drag from Model Explorer and drop on the diagarm
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Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Candidate pane view

Textual analysis can be divided into two views: problem statement view and candidate pane view. While you can edit problem statement and format
text in problem statement view, you can edit and organize candidate objects in candidate pane view. The main characteristic of candidate pane view is,
you can visualize candidate objects as boxes on candidate pane for easy arrangement.

To switch to candidate pane view:
Click Candidate Pane View button.

»

andiate Pane View

Click Candidate Pane View button

The overview of candidate pane view

m

dText |  Type | ipti | Occurrence] Highhi...

Candidate pane view

Editing candidate objects
Candidate pane view is similar to problem statement view where you can rename candidate objects, enter their description, change their highlight color
and type. Except editing in the grid at the bottom, you can also edit through candidate object's box on candidate pane.

To change the model element type of a candidate object, move the mouse over the target candidate object's box. Click the inverted triangle next to the
model element's icon when it reveals. Select a model element type from the pop-up menu.

() watcharchived progr |[_] Uparade to premium ) | Post apinio Update program

ams(1) membership{1)
Sub-Process
O Task |\
I Pool .
= Lane
O Start Event
More 4

2208 A=A

Change model element type
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To change the highlight color of a candidate object, move the mouse over the target candidate object's box. Click the inverted triangle on its top-right

corner when it reveals. Select a color from the pop-up menu.

YT ED

@ Watch archived progr ade to
ams(1) rership

Change highlight color

Filtering candidate objects

To filter specific model element of candidate objects, click Model Filter button. Check target model element(s) from the pop-up menu you want to view

on candidate pane.

22N A=A

B Model Filter

a -
: [ Task (2)
ﬁkﬁl SubFroés{_Z}_ _—

ﬁ
|
-

() Watcharchived progr |(_J] Upgrade to premium
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Check Task

To filter specific highlight of candidate objects, click Highlight Filter button. Check target highlight from the pop-up menu you want to view on
candidate pane.
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Filter color

Freely moving candidate objects
To move candidate object's box, just press the target box and drag it to your preferred location.

(] Upgrade to premium Post opinion{1)
membership(1)

(]  watch archived progr ) Update program sche
ams(1) dule(1)

Press and drag Update program schedule
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Selecting candidate objects
When you click a specific candidate object in the grid at the bottom of candidate pane, the corresponding candidate object's box will be selected on
candidate pane, and vice versa.

m
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(&) ~ Update program sche
dule(1)
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No.. Candidate Class Extracted Text Type Description

l d e d DE ad d =

2 |Upgrade to premium upgrade himself to a premium member | ) Task General Members can upgrad
3 |Post opnion posting their opinion (@) Sub-Process [Premium Members can post ti
4 |Update program schedule update the program schedule (& Sub-Process  |The Administrator has the righ|

Click candidate object in grid

Setting tile layout
Tile layout refers to the selected objects are arranged in horizontal row.

To set tile layout for all candidate object's boxes on candidate pane :

Right click on candidate pane's background and select Tile Layout from the pop-up menu.

) Update program sche
dule(1)

() watcharchived TV pr

ograms(1)
B Tielayout |\ |
= Add Candidate »

U Create Model Element...

Set tile layout

As a result, all candidate objects are arranged in tile layout.

M
e 224 EE

Tile layout

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube
. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Working with glossary

Glossary lets you specific project specific vocabularies, and add description and aliases to them. This chapter will guide you through the process of
adding terms in glossary and how to work with glossary grid.

Identify glossary term

Terms can be identified from text written in working procedure editor. This page tells you how to do.

Glossary grid

Glossary grid is a place for managing glossary. You will learn more about it here.
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Identify glossary term

You identify specific terms by adding them to glossary, and clarify them by defining aliases and entering documentation in any textual documents.
1. Highlight the specific term on Documentation editor, right click on it and select Add "[the highlighted term]" to Glossary from the pop-up

menu.
Documentation:
HTML ~*BIus==E=FReHA-@fQ (4>
To enjoy both archived and live programs, the visitors can ‘
click in the = gis tn _register a3 = ogeneral
member | Add "online register” to Glossary ﬂ
Add Model Element...
Insert Hyperlink...
® Record... ~ Open URL
[] Abstract [|Leaf [|Root []Bus L1
s 24 Add Author Variable N
— Add Date Variable ~

Add "online register" to Glossary

2. When the Glossary Grid page is opened, right click on the newly created term and select Open Term Editor from the pop-up menu.

BagRO8RLllme

Name Aliases Labels Documentation

Online register
|E Open Term Editor L} |
Zp  Create Term

Right click to open term editor

3. In the Term Editor page, open Definition tab.

4. You can define aliases for the term and enter documentation as description for the term. To insert an alias, click Add button and type the alias in
the pop-up Input dialog box. To enter definition, enter under Definition directly.
= Torm Editor - Online registar & &=

Defrvton | Stereotypes | Tagged Vakues

Term:  Orine register Edt

Alases: =3 w»‘_h“‘

TEZEEFRPA-F AL

Sign up av & mesker] via OTV's coline Zgialar Page.

Define aliases and enter documentation

5. As a result, the columns of Aliases and Documentation are filled when you return Glossary Grid page.
Es a2, lme prject
Name | liases |Labels | Documentation |
Onine register |Sign up , |Sign up as a member via OTV's onine register page.

Completed glossary grid

Identify term from flow of events
Highlight the specific term on flow of events editor, right click on it and select Add "[the highlighted term]" to Glossary from the pop-up menu.

+ B FE|Aav EE
. Click in the ST =t : :
. Fillin the online registe r Add "online register" to Glossary Ik ”

. Select the package
. Submit the Form

:Flow of Events «

4

¥ SR VR %

Add "online register" to Glossary
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Identify term from textual analysis
Highlight the specific term on textual analysis, right click on it and select Add "[the highlighted term]" to Glossary from the pop-up menu.

= Textual Analysis1
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Candidate Item...

More 4

No. | CandidateClass | Extracted T

Add "archived TV programs” to Glossary L\\? |

Add Model Element...

Add "archived TV programs" to Glossary

Identify term from shape name
Highlight the specific term when editing a shape inline. Right click on it and select Add "[the highlighted term]" to Glossary from the pop-up menu.

pEpL,

'@‘ Process

Add "Order" to Glossary [

Add term to glossary when renaming shape

Opening term

To read the definition of a term, press the Ctrl key and click on the term from documentation/flow of events content/shape name. By doing so, the

glossary grid will be opened, with the selected term highlighted.

= EP' JEC ﬁst
e enee ]

Besponsible for order

prucessim;l
Ctrl + Click to Open

To open a term

Related Resources

The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube
. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Glossary grid

Glossary grid is a table where you can identify specific glossary term. In addition, you can define aliases and enter documentation for the glossary
term. With Logizian, you can categorize the terms by defining and assigning label(s) to them.

Creating the glossary grid
To open a grid diagram, select Requirement > Glossary Grid from the toolbar.

] | @. O .| F £ A

Reguirement Impact Diagrams Format Copier | Modeling

Requirement Modeling

=
Textual Analysis Glossary Grid
Open Glossary Grid

Overview of glossary grid
3 Glossan-> Glossary Grid B 5

Grid Diagram

Name: Glossary Grid @

Maodel Blement: Term - @
A RERAG=RLL PU-ne Projec ] [Fiter Term (videa-
e |} dalesks i [dpesi 3 1o

ireqig UG ( o >= (u) Sigiy up as a member via OTV's oniine register page.
L '
i - 13
O N0! |
i i H
1 1
H
ONGYORO
Glossary grid
No. Name Description
1 Name You can enter the name of grid in here.
2 Model Element You can select the model element you want to be listed in grid from the drop-dwon menu.

3 Configure Grid Click this button to reveal Name and Model Element. To hide these them, click this button again.

4 Create Term (Insert) Click this button to create a new term.

5 Find To search a term/ phrase, click this button. Enter the keyword of your term/ phrase in Search Text text field and
check the searching field: Name, Aliases, Label or Documentation.

6 Open Term Editor Click this button to open Term Editor page of the selected term. In Term Editor page, you can define the term,
stereotypes and tagged values.

7 Open Specification... Click this button to open the specification dialog box of the selected term. In Term Specification dialog box, you
can define aliases, assign label and enter documentation.

8 Export to Excel To save and export the selected term into a new Excel.

9 Import to Excel To import the selected term to an existing Excel.

10 Show View Click this button to show the orginal model element of the selected term.

11 Visualize... Click this button to duplicate the selected model element on the chosen digram (in either new diagram or existing

diagram).

Glossary grid
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12

Manage Label

Label can be defined to categorize terms. This button is for adding, editing and deleting labels.

13 Configure columns... Add/ remove property column(s) in Term list.

14 Fresh To update the display on the Term list.

15 Project To select the scope for showing mdoel elements on Term list.

16 Filter Term To enter the keyword of your target term with *, you can find it in shortcut.
17 Clear filter To clear all words you typed in Filter Term.

18 Term list All created term will be listed in here.

Organizing terms with labels

The overview of glossary grid

With Logizian, you can categorize the terms by defining and assigning label(s) to them.

Defining label

1.

After you have selected a term in any textual documentation to add it to glossary, the glossary grid is opened. Click Manage Label button.

Es aER28RLMee

MName Alizses Labels W' TDocume
general
live
premium
archived
Click Manage Label

In the pop-up Manage Label dialog box, click Add... button to create a label.

-
@ Manage Label

2

Labels:

MName

Description

Open Spedfication...

[

Add a label
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3. In the Glossary Label Specification dialog box, name the label and select a color for it. Click OK button to confirm.

Glossary Label Specification (S
General | Traceabiity | References | Project Management | Comments |
[
Color: I:I Pink
l?ocumerltation: ) . Default (:._.;-m,,-n‘l
ML * B I U wmooe 7]
|| cyan H
I Darkgray §
I Gray
[ Green
[ uight gray
I Magenta E
orange .~
Il Red
[ white
[ Yellow -
[ Reset | [ ok || Cencdl || oy [[ Heb |

Enter name and select a color

4. Click OK button in the Manage Label dialog box.

Assigning label
1. Let's assign a specific label to the corresponding term. Click the small plus button under Labels column of your target term.

Name Aliases Labels

general i

live

premium
archived

Click the small plus button

NOTE: If the Labels column doesn't show on the grid, you can click the Configure columns... button. Open Properties tab and select it under
Others folder..
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2.

3.

In the pop-up Add Label dialog box, check a label and then click OK button.

-
Add Label

2

[ All ] [ None

J

Name
7 embership
Program

| [ cancel |

NOTE: You can apply multiple labels to a term. Check the applicable labels in the Add Label dialog box.

Check a label

As a result, a specific label is assigned to the corresponding term.

Mame Aliases Labels
general Membership
live

premium

archived

Membership is assigned to general

Filtering terms with specific label

1.

If you want to list terms of specific label, click the combo box of Project and select With Label....

Al Diagrams
Within Diagram...
Mo Diagram

All Labels
With Label... k
Without Label

Select With Label...

Glossary grid
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2.

3.

Exporting glossary to Excel
You can export the glossary, along with its terms into an Excel file, and import it back to share with your teammates.

1.

3.

In the Scope dialog box, check the specific label you want to be listed and then click OK button.

r® Scope

[S)

Name
v b
Program

QK

] [ Cancel

Check Membership

As a result, terms with specific label are listed in the grid.

MName Aliases Labels
general Membership
premium Membership

Terms with Membership label are listed

In the Glossary Grid, click Export to Excel button.

@ aEBEB
by

B J il e

Name Aliases Labels [
general Membership

live
premium Membership
archived

Click Export to Excel button

In the Export Excel dialog box, enter the output directory. Click Export button.

Export Excel

|0utput Path: |C:\WP project\glossary-export. xls

Export Style: :Diagram Per Sheet

Enter the output directory

To import the Excel back to your project for a mass modification or review, select File > Import > Excel... from the main menu.

Related Resources

The following resources may help you learn more about the topic discussed in this page.

.

New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

Visual Paradigm on YouTube

Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

Contact us if you need any help or have any suggestion
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Grid diagram

A grid enables you to list elements in tabular form. The columns are the properties of model elements.

Creating grid diagram

Shows you how to create a grid.

Creating element in grid

Create elements through the grid interface.

Adding/removing property columns

Add extra property columns to grid.

Setting the scope of grid content

Adjust the range of elements to list, like to list elements in specific model.

Filter and find

Filter and find elements in grid.
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Creating grid diagram

Logizian introduces model element grids to provide a convenient way to model and overview model elements within your project. You can create a grid
to list whatever model element type you like, and customize the properties of model element being shown inside the grid.

To create a grid diagram:
1. Select Diagrams > Grid Diagram from the toolbar.

O | Fe€ B B &

Diagrams Format Copier | Modeling Doc Team Inten

Diagrams

Overview Diagram Grid Diagram

Click Grid Diagram

2. When the Grid Diagram is opened, enter name for the grid.
= Models -> Business Process Grid
Grid Diagram

Name: Business Process Grid |

Model Element: Model -

Enter grid's name

3. Select a model element type from the combo box of Model Element.
Name: Business Process Grid

Model Element: | JEFEE] -

& =

MName

E7 Business Rule

& 5] Model
£33 Stereotype

= Term

Select Business Rule

MAAAl~

The model element of selected type will then be shown on the grid.
Model Element; Business Rule| -

Ee-gabhRAxne

| Documentation * |
Patient |A patient folows the instruction ...
Hosptal |a hospital hires doctors with diff...
Doctor A doctor looks after his/her pate...

The model element of selected type is shown

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Creating element in grid
Besides creating elements by drawing them on diagram, you can also create them in grid. Creating elements in grid gives you an overview on all
elements of same type.

1. After you select model element from the combo box of Model Element, the corresponding model element button will appear. To create the
model element, click the model element button.

Grid Diagram

Mame: Business Process Grid

& -
@ @ @ JD_ :Project

|Documentation |

[Mame

Click Create Model button

2. Enter name for the newly created model element and then press Enter to confirm.

=R =L

Mame Documentation

Business Mode|

Enter name

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube
. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Adding/removing property columns

In grid, rows represent model elements while the columns show their properties. Name and documentation columns are shown by default, in addition,

you can optionally add or remove columns to display the data you are interested in.
To add an extra property column:

1. Click Configure Columns... button.

= Models -> Models Grid

Grid Diagram

Name: Models Grid

Model Element: |Model -
HEX Y L PEE
Name Documentation L\}
Models Configure columns...

Click Configure Columns... button

2. In the Configure Columns dialog box, select your preferred property under Properties tab and then click OK button.

{#) Configure Columns e
Avalable Coumns: Sehected Columns:

Propertes | Tagged values Name (P)
" ® leot m Documentation (P)

@ Root

|, Project Management
* Author
# Create date time
# Difficuity
# Discpine
& Iteration

: P?m\:semm&d r‘. ® |t

& Priority &
& Stats &
@ Version

|, Others
# Code Signature
# Connect To Code Modsl .+
[ Viodel Type [
® Parent
® References
* Stereotypes
#® TransitFrom P - Property
# Transit To - TV - Tagged Vale

——— ) (e [

m

Select Model Type

As a result, the selected property column is inserted in the grid.

EAefR=lme

Mame Documentation ]Modd Type
Business Model Model
Design Model Model
Implementation Model Model
New Model Model
DeploymentModel Model

Model Type column is added

To remove a property column:

1. Click Configure Columns... button.

Adding/removing property columns
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In the Configure Columns dialog box, select your undesired property under Selected Columns and then click OK button.

() Configure Columns

i

Avalable Columns:
Propertes | Tagged values
. General

® Abstract
® Voices
* View count
. Detais
@ Comments
@ Leaf
® Root
| Project Management
* Author
® Create date tme
# Difficulty

As a result, the deselected property column will be removed from the grid.

Related Resources

The following resources may help you learn more about the topic discussed in this page.

.

.

m

Selected Columns:

Name (F)
Documentation (P)

>
(€4

Remove Model Type column

New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

Visual Paradigm on YouTube

Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

Contact us if you need any help or have any suggestion

Adding/removing property columns
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Setting the scope of grid content
In grid, you can customize the scope of grid content after you have created various types of model elements. After that, your desired model elements
within a particular scope will be shown on the grid.

To set the scope of grid content:

1. Select your desired scope from the combo box of Project.

= Models -> Models Grid

Name:

Grid Diagram

Models Grid

Model Element: |Model

-

FHEFY T PR proct -
Name | Documentation Project
Models Root Model Element k‘
All Diagrams
Within Diagram...
Mo Diagram
Select scope
NOTE: Within Model or Package: Select this when you want to show all selected model element types within a particular model/ package.
Root Model Element: Select this when you want to show all selected model element types under root node.
All Diagrams: Select this when you want to show all selected model element types within all diagrams.
Within Diagram: Select this when you want to show all selected model element types within a particular diagram.
No Diagram: Select this when you want to show all selected model elements without diagram.
2. As a result, grid content is updated to list the model elements that fit the selected scope.

BEY YT PEE

MName Documentation Maodel Type
Animal Model <
AnimalFarm Model

Related Resources

The scope of grid content

[(3] Design Model -

The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion

Setting the scope of grid content

P. 523



Filter and find

Logizian enables you to create a grid to list whatever model element type you like, and customize the properties of model element being shown inside
the grid. Except creating a grid with your preferred model element type, you can also search your target model element in shortcut through filter and
find.

Filtering

1. Type the word/ phrase in filter.

2. Model element(s) matching the word/ phrase you typed will be shown in the grid subsequently.
EeadRAse o o] s .
Animal Model ’

AnimalFarm | [Model o=

Model elements match the word/ phrase you typed

Finding
1. Click Find button.

Em

Name

Click Find button

2. Type the word/ phrase in Search Text and then check either Name or Documentation (or both). Check Name if you want to search the name
model elements matches the word/ phrase you typed while check Documentation if you want to search the documentation of model elements
matches the word/ phrase you typed. Check both if you want to search the name or the documentation of model elements matches the word/
phrase you typed.

Find

Search Text: Animal

ame [~] Documentation

Check Name

3. Click Find button behind Search Text.
Find

Search Text: Animal Find |

[¥] Name: | Documentation

Click Find button

4. Model element(s) matching the word/ phrase you typed will be highlighted in the grid subsequently.

Name Documentation Model Type
Business Model Model
Design Model Model
Implementation Model Model
New Model Model
DeploymentModel Model

Model elements are highlighted

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian

. Visual Paradigm on YouTube
. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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Creating process map diagram
Process map diagram gives an overview that shows the processes needed to approach a business goal. It is rather in a upper level of analyzing and
understanding a business process.

Order Process
Recewed Order

. Goods

A sample process map diagram

Creating process map diagram

. Click on Business on toolbar and select Process Map Diagram from the drop down menu .
. Right click on Process Map Diagram in Diagram Navigator, under the Business Modeling category, and select New Process Map
Diagram from the popup menu.
. Select File > New Diagram > Business Modeling > Process Map Diagram from the main menu.
</h2>
Notations
Name Representation Description
Process — A process is a part of process flow in achieving a goal.
Order
Send - An event that initiate the process chain.
Received
Receive Eiais The result of process chain.
Delivered

Process Link ————————= The flow of process.

A list of supported notations in process map diagram

Related Resources
The following resources may help you learn more about the topic discussed in this page.

. New to Logizian? We have a lot of business process modeling tutorials written to help you get started with Logizian
. Visual Paradigm on YouTube

. Visual Paradigm Know-How - Tips and tricks, Q&A, solutions to users' problems

. Contact us if you need any help or have any suggestion
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